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Types of Images - Bitmap

• Made up of small 
color squares called 
pixels

• The number of pixels 
in an image can 
range from a few 
hundred to millions

• The image will 
become distorted if 
you zoom in (like the 
image to the right)
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Types of Images - Animated Bitmap

• A set of bitmap 
images that play in 
sequence. 

• Usually loops

• Impractical for long 
animations

• Used to made banner 
ads

Types of Images - Vector

• A visual 
representation of 
numerical lines and 

curves – sometimes 
filled in with color

• Does not distort when 
zoomed in

• Very useful for 
representing text
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Image Modes - Colors:
Grayscale 

• Each pixel can only 
represent black, white 
or a shade of gray

• Creates much smaller 
image files

• Not all pictures that 
appear black and 
white are done in 
grayscale

Image Modes - Colors:
Indexed Color

• These images contain 
a listing (index) of all 
the colors used

• File size is reduced, 
but with a loss of 
precision

• More useful for small 
images

• The gif file format 
uses indexed color
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Image Modes - Colors:
RGB

• RGB (or Red, Green, 
Blue) is the color system 
modern monitors use to 
display

• Most images intended for 
use on a computer are 
RGB images

• Red, Green, and Blue are 
the three primary colors 
in light (not Red, Yellow, 
and Blue)

• RGB is an additive color 
model because colors are 
added to a black base

Image Modes - Colors:
CMYK

• CMYK (Cyan, Magenta, 
Yellow, and Black) is 
most commonly used for 
printing

• It is a subtractive color 
model, because the 
colors are darkening the 
white background

• Photoshop can convert 
an image from RGB to 
CMYK and back easily, 
but with a possible loss of 
information
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Image Modes - Channels

• In Photoshop, color 
information about an 
image is separated into 
channels; RGB images 
have three channels, 
CMYK images have four

• Outside of Photoshop, 
color modes are often 
referred to by the total 
number of bits per pixel –
for example 8-bit color is 
capable of displaying 256 
different colors

Image Modes - Channels:
8 bits / channel

• The range of colors 
available depends on 
how long the binary 
numbers used to 
represent each pixel 
are

• 8 bits per channel 
(a.k.a. 24-bit color) is 
adequate for candid 
digital photos or 
desktop backgrounds
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Image Modes - Channels:

16 bits / channel

� 16 bits per channel allows for a much 
greater range of color

� These images take up much more 
space on a hard drive

� Many file formats do not support 16-
bit color including jpg, gif, and pct

� Converting from 16 to 8-bit color is a 
lossy transformation – information is 
permanently discarded

Image Modes - Channels:
32 bits / channel

• 32-bit color is a 
misnomer, it is actually 
24-bit color with the 

remaining 8 bits used to 
store alpha information

• Alpha information can 

define parts of an image 
as transparent, and unlike 

transparent gifs, there 
can be partial 

transparency
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Photoshop Notes

� Photoshop is made by Adobe and is currently in 
version 10 (a.k.a. CS3) – it has been around a long 
time and has improved a lot since its inception

� It is the industry standard for bitmap picture editing, 
nothing else comes close

� Photoshop can be very resource intensive –
depending on how large the images you’re working 
with are – lots of RAM (> 1GB) is very helpful

� Almost any action in Photoshop can be undone. In fact 
you can step backwards many times. Try using the 
History Palette (Window -> History)

The Photoshop File Format 

(.psd)

� Photoshop has its own type of image files, 
the PhotoShop Document or PSD

� PSDs are very flexible, can use any color 
mode, and can have 8, 16, or 32-bit color

� They can also get quite large, up to 
hundreds of megabytes

� PSDs are the only file format that can save 
layers

� Typically, a Photoshop user will save their 
project as a PSD, then export into other file 
formats
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The Photoshop Interface

Toolbar
Finding hidden tools

• Many of the tools in the 
toolbar share a location 
with other related tools

• Left-click and hold the 
mouse button down to 
bring up all the related 

tools

• If using a shortcut key, 

hold down shift and hit 
the key repeatedly to 

cycle through the tools
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Toolbar

Shortcut keys 

� In many cases, it is faster and easier to type 
shortcut keys than to go through a menu

� When using the menus, Photoshop displays 
shortcuts to the right of the item which they 
are assigned to

� Navigation is one of the most important 
uses of the keyboard: 

� Spacebar + click and drag to pan around the 
image.

� Ctrl + Spacebar + left click to zoom in

� Ctrl + Alt + Spacebar + left click to zoom out

Toolbar
Brush Tool (B)

• The Brush tool paints 
a consistent solid 
color over the image

• This is not usually 
desirable when 
working with 
photographs

• With experience, 
useful techniques can 
be discovered
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Toolbar
Brush Presets

• On the menu bar at the 

top of the screen there is 
a thumbnail of your 

current brush with the 

size (in pixels) below it

• Clicking on the thumbnail 

will open the brush 
presets and sliders that 
allow you to control the 
size and Hardness of the 
brush

Toolbar
Color Picker 

• There are many ways to 
choose a color in 
Photoshop

• Near the bottom of the 
tools palate are two 
overlapping squares – the 

foreground and 
background colors.

• Click on the square on 
the top left to bring up a 

color picker
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Toolbar
Gradient Tool (G)

• The Gradient Tool 

creates an even fade 
from one color into 

transparency or another 

color

• The menu bar has 

options for colors as well 
as shapes

• By default the foreground 
and background colors 
are used

Palette
Navigator

• The Navigator palette 
shows the whole 
image, even when 
you are zoomed in

• Dragging the red 
square around the 
palette will pan your 
view of the image

• The slider at the 
bottom controls your 
zoom level 
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Palette
Layers: New

• Layers are parts of 
images that are stacked 
on top of each other and 
affect the images below 
them

• Complex images can 
have many layers 
interacting in different 
ways

• To create a new layer, 
click the icon at the 
bottom of the layers 
palette, as shown here

Palette 
Layers: Delete

• To delete a layer, 
highlight it on the 
layers palette, then 

click on the trash can 
icon at the bottom

• Note that there must 
always be at least 
one layer present.
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Palette
Layers: Folders

• If the number of 
layers becomes 
unwieldy, layers can 
be put into folders

• Click the folders 
button to create a 
new folder

• Double click folder 
and layer names to 
rename them

Palette
Layers: Transparency

• Any layer except the 
background can be 
made transparent

• Select the layer you 
wish to alter on the 
layers palette, then 
adjust the opacity –
0% is invisible, 100% 
is fully opaque 
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Toolbar
Eraser (E)

• The Eraser Tool does 
exactly what it sounds 
like – however, it will not 
work on the Background 
layer

• The grid of gray and 
white squares indicates 
that there is no color 
information on that part of 
the image

• Lower layers will show 
through erased areas

Palette
Layers: Styles

• There are many ways for 
overlapping layers to interact

• A partially transparent upper 
layer can be altered by bring 
up the styles menu (Layer -> 
Layer Style)

• The General Blending Options 
allows you to “soften” or 
“harden” upper layers

• The only way to learn what an 
option does is to try it!
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Palette 
Layers: Filters

• Filters are powerful 
algorithms that alter the 
image in a variety of ways

• The Filter Gallery (Filter 
menu) allows you to 
preview how a filter would 
look applied to the current 
layer

• Filters are often overused 
by beginners, try to use 
them to achieve a goal, 
not just for their own sake

Toolbar
Type Tool

• Compositing text and 
images is a very 
common use for 
Photoshop

• Click on an image 
with the Type Tool 
and begin typing to 
add text

• Clicking and dragging 
restricts the text to a 
rectangular area
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Toolbar
Type Tool

• When you are done 
typing, you must click the 
check box (or Ctrl + 
Enter) to commit the 
changes

• Clicking the ‘no’ symbol 
(or hitting the Escape 
key) will exit the tool 
without any changes 
being made

• Basic formatting tools are 
on the menu bar

Selections:
Marquee Tool (M)

• The Marquee Tool is 
used to select an area 
evenly

• The tool has rectangular 
and elliptical modes

• While a rectangle is 

selected choosing crop 
(Image -> Crop) will cut 

out the unselected part of 
the image
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Selections:
Magic Wand Tool (W)

• The Magic Wand Tool 
allows to select colors 
that are similar to a 
chosen color

• Clicking anywhere on the 
image will select pixels 
that are “similar” to the 
chosen pixel, as defined 
by the tolerance value

• Shift clicking will add new 
selections to the current 
selection

Selections:

Other Tools

� To invert the selection on an image go to 
Select -> Inverse

� To select the area covered by a particular 
layer, hold down Ctrl and click on the 
thumbnail portion of the layer on the 
Layers Palette

� Selection tools can complement each other 
– with any selection tool active holding 
down Shift will add to the selection, holding 
down Alt will subtract from the selection
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Image Adjustments:
Color Balance 

• This palette (Image -> 
Adjustments -> Color 
Balance or Ctrl + B) is 
very useful for adjusting 
the overall colors in an 
image or selection

• The controls are divided 
into Shadows, Midtones, 
and Highlights, so 
adjustments will effect 
dark and light areas 
differently

Image Adjustments:
Brightness/Contrast

• A simple but useful 
tool (Image -> 
Adjustments -> 
Brightness/Contrast)

• Increasing the 
contrast can make an 
image “pop”

• Decreasing the 
contrast will made an 
image look faded
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Image Adjustments:
Curves 

• An incredibly powerful tool 
(Ctrl + M)

• The diagonal line represents 
the transition from dark 
(bottom left) to light (upper 
right)

• Dragging a point in the line will 
effect pixels at that level of 
brightness more

• For example, clicking near the 
top of the line and dragging 
down would make the lightest 
pixels darker

• Clicking on the line (without 
dragging) allows you to place 
more points

Image Adjustments:
Levels 

• One of the most useful and 
powerful tools in Photoshop 
(Ctrl + L)

• Like the Curves tool, left to 
right here represents the actual 
distribution of pixels (by 
brightness) in the current 
image

• The three control points below 
the graph can be dragged to 
adjust the brightness of each 
area

• Clicking on the Auto button 
makes Photoshop guess how 
to adjust the image 
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Image Adjustments:
Hue/Saturation

• Another useful tool 
(Ctrl + U)

• Hue is the exact color 
(Red-Orange vs. Orange)

• Saturation is the amount
of color for that hue (e.g. 
the difference between 
red and pink)

• Lightness is the relative 
brightness of the color

• These are very important 
and commonly used 
digital color terms

Toolbar
Dodge & Burn (O)

• Dodge and Burn simulate 
traditional tools used in 
photography

• They can be used to 
create highlights and 
shadows while 

maintaining the 
appearance of an 

unedited photograph

• Good brush selection is 

key
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Toolbar
Blur (R)

• The Blur tool removes 
detail

• It can be used to 
“soften” an image, 
smooth human skin, 
and blur sharp edges

• It’s best to zoom out 
frequently when using 
this tool to see the 
effect on the whole 
image

Toolbar
Rubber Stamp (S)

• The Rubber Stamp Tool 
copies information from 
one part of an image to 
another via a brush

• Hold down Alt and click to 
set the source area –
then click elsewhere on 
the image to paint 

• Skillful use of this tool can 
make unwanted parts of 
images disappear

• Try using the tool with 
less than 100% opacity 
(set on the menu bar)
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Image Adjustments:
Image Size 

• Image size (Image -> 
Image Size) is a critical 
aspect of all digital 
images, and can be 
adjusted via this tool

• Pixel Dimensions are the 
more important part, 
Document Size is for 
printing

• Constrain Proportions 
should be checked in 
most cases

Image Adjustments:
Canvas Size 

• If an the area around
an image needs to be 
bigger, it can be 
adjusted with Canvas 
Size (Image -> 
Canvas Size)

• The nine-square box 
with arrows allows 
you to choose which 
direction the image 
will expand to
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Transformations:
Free Transform

• With part of the image or 
a non-background layer 
selected, hit Ctrl-T to free 
transform

• The transformed area can 
then be moved, rotated, 
squashed, stretched, and 
distorted

• Hold down Shift while 
dragging a corner to size 
proportionally

• Hitting Enter will commit 
the changes, Esc will 
cancel the operation


